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Introduction 
 
Welcome to the Lightwave 7.5 Beginners Guide! This Guide is only an update from my Lightwave 6.5 
Beginners Guide to suit Lightwave 7.5; the content is pretty much the same, however, a few new 
additions has been made in the Tutorial section. We will start out with an introduction to 3D in general, 
and if you feel that you know the basic concepts already, you can simply skip this part and dive directly 
into the Lightwave Parts. The best way to get to know the Interface and how tools work is to use them, 
and tutorials are great for this purpose, so we will be doing a tutorial as I explain the bits and pieces of 
Lightwave. 
 
An Introduction to 3D 
 
I’d say that the most important thing you need when you want to create 3D art is your imagination, a 
picture in your head of how you want it to turn out. Your choice of 3D software doesn’t really matter, 
since it always comes out to the artist and how creative one can be. All 3D programs are based on the 
same idea, where you build up your scenes with Objects, and Objects are built up by Points and 
Polygons. Take a look at the two pictures below, it’s just a box right? Well this is an object, a very 
simple one, but still an object. 
 

 
Picture 1 

 
Picture 2 

 
As you can see in Picture 1, there’s a point in each corner of the box. Picture 2 on the other hand 
shows the Polygons, and these are the ones you give materials to, and they are the ones you will see 
in the final render. I guess you already knew that 3D stands for 3Dimensional, and this is what you 
work with in any 3D program out there. In Lightwave, these Dimensions are called X, Y and Z, and 
these could be described as Left/Right, Up/Down and Near/Far respectively. 
 
What’s the advantage of using a 3D program then? Well, you can create nice artwork by drawing them 
in a 2D program, but when it comes to animating what you’ve created it becomes a bit harder, and this 
is where the 3D program has an advantage. Another thing to mention is that you can change anything 
in the pictures you create. If you didn’t like the material on a certain object, or if the light setting was 
wrong, just change it and re-render. 
 
That’ll do for an introduction; lets get going with Lightwave! 
 
 
 
 
 
 



The Basics of Lightwave 
 
Follow the installation instructions and install Lightwave on your harddrive. Lightwave comes as two 
separate programs, Lightwave Layout and Lightwave Modeler, and from now on they will just be 
referred to as Layout and Modeler. 
 
Lightwave Layout 
 
If you start Layout up it should look something like picture 3. 
 

 
Picture 3: Lightwave Layout 

 
This is where you load objects you’ve created, give them textures, edit lights & cameras, animate 
things and render your final pictures. As you can see I have added a few descriptions on some of the 
items in picture 3. However, we will not start the tour in Layout, but we will get back to it later on in the 
Guide. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Lightwave Modeler 
 
If you load Modeler up, it should look something like picture 4. 
 

 
Picture 4: Lightwave Modeler 

 
The Modeler lets you model all the necessary objects you need for your scene. You also prepare your 
objects for Layout here, like attaching surfaces to them etc. I put a few descriptions on picture 4 as 
well, and we will get to know the interface better next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Getting to know Modeler 
 
We’ll start with a few explanations on how Lightwave is built up, and then we’ll start the main tutorial 
and learn the tools we use as we go along. 
 
The Interface & Workflow 
 
The Workflow is one of Lightwave’s stronger areas. If you look at the Interface, you’ll see that every 
Tool or Button is named with text. No image buttons that takes ages to learn, plus that the interface is 
very clean. You also have shortcuts on your keyboard for almost every Tool in Lightwave. The menus 
are also configurable and you can create your own menus to fit your own needs. 
 
Keyboard Shortcuts 
 
If you look at the “Box” Tool button in the “Create” Tab, you’ll see that in the right side of the button 
there’s an “X”. This means that a capital X is the shortcut key for the Box Tool, so if you hit “shift+X” 
on your keyboard, you’ll see that the Box Tool gets activated. This is how it works with all the other 
Tools that have a key assigned to them as well. 
 
If you would like to assign a shortcut to a Tool that perhaps doesn’t have one, hit “alt+F9” on your 
keyboard and you will get a list over all the Tools available, and a list over all the keys on your 
keyboard. You can also access certain setting panels from the “Modeler” pull-down menu at the top 
left of Modeler. 
 
Plugins 
 
Lightwave comes with lots of Plugins that you need to get things working properly. We will start by 
installing these in Modeler. At the top left of the Modeler window, you should see a button named 
“Modeler”. If you click this one with your Left Mouse Button, you will get a small menu with a few 
sections and options. One of the sections is named “Plug-ins”, so click that one and a sub-menu will 
appear. From this sub-menu, select “Edit Plug-ins”. 
 
A Panel will appear and this is where you control your Plugins. If you didn’t install your Plugins 
already, we will do it now. Click the “Scan Directory” button on the right of this Panel, and a browser 
window will appear. Browse to your Lightwave Directory (on your harddrive) and find the Folder named 
“Plugins”, simply just mark this Folder and click OK. Lightwave will now install all the Plugins it will find 
automatically. When it’s done you can simply close down the Plug-ins Panel. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Display Options 
 
Modeler has got four Viewports by default. Each of these Viewports can have their own unique 
settings. Open up the Display Options panel by hitting “d” on your keyboard, it should look something 
like picture 5. 
 

 
Picture 5: Display Options Panel 

 
The first tab called “Layout” in this panel contains a few global settings. This means that if you change 
something here it will take place in all of the Viewports. As you can see I’ve turned off a few options 
here, and this is just my own preference. What we will change though, is the Top Right Viewport 
(Perspective View) and how that one should appear. So to edit just one of the Viewports, click the 
“Viewports” Tab. The first thing to do here is choose which of the Viewports we want to edit, so click 
on the “TR” (Top Right) button to select that one, then use the options that picture 6 are showing. 
 

 
Picture 6: The settings for the Top Right Viewport 

 



Once you’ve entered all the settings here, just click OK to save it, and if you look at the perspective 
view now, it should look something like picture 7. 
 

 
Picture 7: The Top Right View/The Perspective View 

 
There are a few more things we are going to change in the Display Options Panel, so hit “d” once 
more to bring it up again. Click the last Tab – “Units”, then use the settings shown in picture 8. 
 

 
Picture 8: The Units settings 

 
Once you’re done with these settings, click OK again to save the changes. 
 



Each Viewport has got a Pan, Rotate and Zoom Tool, and a variety of render modes, picture 9 shows 
the Toolbar for one of the Viewports. 
 

 
Picture 9: Viewport Tools 

 
As you can see on picture 9, this view is set to “Top XZ”, but you can easily change it to any of the 
others by using this pull-down menu. Just to the right of the View menu you can select what type of 
Render Mode you wish to use for that view, such as Wireframe, Smooth Shaded and so on. The Pan 
Tool lets you Pan the Viewport, and if you prefer to use the mouse and keyboard, just hold down the 
“Alt” key while you click inside the view with your Left Mouse Button and drag it around. The Rotate 
Tool only works in the Perspective View. In any Perspective view you have, you can also hold down 
the “Alt” key while dragging in the view, which will work as a Rotate Tool. The Zoom Tool will zoom in 
or out using the centre of the view as a target. 
 
Modes & Tools 
 
At the bottom of Modeler, you should see two buttons named “Points” and “Polygons”. These are the 
two modes of Modeler, and will give you more control over what you are doing when you model your 
objects. If you read the first part of this Guide then you should know what Points & Polygons are, 
otherwise, move back and read it. It is essential that you know what Points and Polygons are if you 
want to get anywhere with modelling. 
 
The Tools that come with Modeler, has been nicely categorised under the Tabs, just above the Top 
Left Viewport. The “Create” Tab is open by default when you load Modeler, and if you click any of the 
other ones, you should see that the Tools to the left of Modeler changes. To activate a Tool, simply 
click on it once. Activate the Box Tool in the “Create” Tab now. If you move your mouse over any of 
the Viewports now you can see that the mouse pointer has turned in to a small 3D box. The same 
thing happens with the other Primitive Object Tools, the Ball Tool turns into a small ball, the Disc Tool 
into a small cylinder and so on. To Deactivate a Tool simply click it again or hit “Space” on your 
keyboard. We are going to go through the most common tools a bit later in this Guide, to get to know 
them better. 
 
 
 
 
 
 
 
 
 
 
 
 



The Numeric Panel 
 
Almost every Tool in Modeler comes with a Numeric Panel. This panel lets you enter exact values of 
how you want the final result to turn out. For example, using the Numeric Panel when you have the 
Box Tool activated lets you enter exact values of how big the box should be, and if you’re using it 
when you have the Move Tool activated, you can enter an exact value as to how much you want to 
move the object and so on.  
 
Activate the Box Tool and hit “n” on your keyboard. Once you hit “n” the Numeric Panel will come up 
showing you default values of the Tool you selected, in this case the Box Tool. Once you activated the 
Numeric Panel, a box was created in real-time in the ViewPorts of Modeler, and as you make changes 
in the Numeric Panel, it will affect the Box in the ViewPorts. Close down the Numeric Panel by clicking 
“n” once more (or by clicking the “X” at the top right of the Numeric Panel window), and then hit 
“Space” on your keyboard to deactivate the Box Tool and to create the Box. Don’t delete this box; we’ll 
need it later on. 
 
The Hub 
 
The Hub is what Lightwave uses to communicate between the Layout and the Modeler. When you’ve 
finished modelling your objects for instance, simply send them to layout via the Hub. This increases 
the workflow even more, and makes Lightwave more like one program instead of two. As soon as you 
start Lightwave up, the Hub will automatically start running, you’ll notice a small green icon in the 
System Tray. If you don’t have enough ram in your machine, and Lightwave tends to get slow after a 
whiles usage, then you can turn the Hub off via the System Tray, its requirements are pretty high. 
 
If you would like to run without the Hub permanently, then do the following steps. Add two shortcuts to 
Layout and Modeler in your Windows hotbar (down where the Start menu is). Right click the Layout 
shortcut and select Properties. In the Window that comes up, you should have a “Target” string, 
indicating where on your harddrive the executables are. In the end of this string, add “-0”, making it 
look something like: 
 
...Newtek\Programs\Lightwav.exe -0 
 
Do the same with the Modeler shortcut, and the next time you run either of them, the Hub will not start 
automatically, saving you lots of RAM. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Objects & Layers 
 
You can have many objects loaded at the same time in Modeler, and just above the Top Right 
Viewport you should see a pull-down menu where it currently says “Unnamed”. This is the object you 
are working on at the moment, and if you have more than one object loaded in Modeler, you can 
switch to which one you wish to work with here. 
 
To give you even more control over your objects while you work with them, Modeler brings you Layers. 
Each object can have 990 layers, and this is more than plenty. Just above the Top Right Viewport you 
should see 10 small boxes, and these are the layers. Picture 10 shows the Layer Tools. 
 

 
Picture 10: The Layer Tools 

 
The one to the very left is lit up with a yellow colour, which means that it is active. As you can see 
there’s a little black dot in this Layer. Remember the Box we created earlier? Well, the little black dot 
indicates that this layer has got an object in it. 
 
If you look at picture 11 you will see that each of these boxes is divided in two. The Top part indicates 
Foreground Layer, and the Bottom part indicates Background Layer. 
 

 
Picture 11: A Closer look on the Layers 

 
 
 
 
 
 
 
 
 
 



One of the new things since LW6.5 are the Layer Groups. Earlier you could only have 10 layers per 
objects, but with this feature you can have 990. 10 Layers per group and a total of 99 groups. Picture 
12 shows the Layer Groups. 
 

 
Picture 12: The Layer Groups 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Lightwave Universe 
 
Both Modeler and Layout has something called Lightwave Universe, and the Universe has got a 
centre spot. As you can see in the four views of Modeler, there are two lines in the grid pattern that are 
a bit thicker than the others. Where these two meet, that’s the exact centre. The values for X, Y and Z 
here are all zero.  
 
Working in the Bottom Left Viewport, put your mouse pointer at the exact centre and watch the 
Position Window. It should look something like picture 13. 
 

 
Picture 13: Closer look at the Axes 

 
The red dot in the middle of the View indicates the centre of the Universe, and as you can see in the 
Position window, the values are both zero there. The picture also shows that each axis has got a 
negative and positive side. In my example I’m using the “Back” View, or the Bottom Left Viewport, and 
this viewport shows the X and Y axis. Left of the vertical centre line you have the negative X, and on 
the right you have the positive X. Below the horizontal centre line you have the negative Y, and above 
you have the positive Y. Does it sound hard? Well, I’ve made a few pictures to ease things up a bit.  
 
 
 
 
 
 
 
 
 
 
 
 
 



Picture 14 shows 4 different positions for the mouse pointer, which is indicated by the little red dot. 
Note that the Grid Size is set to 500mm, and therefore each square in the grid pattern indicates 
500x500 millimetres of space. 
 

 
Picture 14: 4 different positions for the mouse pointer 

 
All of the views in picture 14 show the Back View (Bottom Left Viewport), and you can try this out 
yourself by just moving your mouse pointer in the Viewport. 
 
There you have some information on how Modeler is built up and how things work in general. We will 
now start the main Tutorial, and while we go along we will do a few smaller tutorials on the tools we 
use etc. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 



Tutorial – Creating a Glass Bowl 
 
Okay, lets start using Lightwave for real then. Keep your Modeler running, and to the top left, click the 
“File” pull-down menu and select “Close All Objects”. This will clear the Modeler so we can start over 
with our new project. In our first Tutorial we will be creating a Glass Bowl, and here are some of the 
things you get to learn and use. 
 
Box Tool 
Pen Tool 
Lathe Tool 
Flipping Polygons 
Assigning Surfaces 
Basic Subpatches 
Using Layers 
Glass Materials 
Reflective Materials 
Basic Camera Settings 
Basic Light Settings 
Basic Rendering Options 
 
 
Picture 15 shows the final render. 
 

 
Picture 15: The final Glass Bowl Picture 

 
 
 
 
 
 



The Bowl Shape 
 
We are going to use the Pen Tool to create an outer shape of the bowl, but before we do this, we need 
to adjust the Modeler. In the Bottom Left Viewport, change the View to “Back (XY)” if it isn’t already, 
then place your mouse pointer in the centre of all four views and drag it up to the right. This will 
increase the size of the “Back” view and we will have more control over what we do. Use the Pan tool 
in the Back Viewport and drag until the centre of the universe is at the bottom left, look at Picture 16 
and you’ll know what I mean. 
 

 
Picture 16: Prepare the Modeler 

 
Now how do you set the grid size to 10mm then? Well, it’s quite simple. When you use the “Zoom” 
Tool, Modeler will automatically adjust the grid size whether you zoom in or out. In the Back View, click 
the “Zoom” button and drag with your mouse to zoom in. Keep an eye on the Grid Size as you do this, 
because you’ll notice that the Grid Size changes. So zoom in until the grid size says “10mm”. Have a 
look at picture 16 again to see what it should look like.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 



The Pen Tool 
 
The Pen Tool is quite simple to use. It lets you place points, and as you do it also connects the points 
with polygons. Like many of the other Tools in Modeler, the Pen Tool comes with a Numeric Panel, 
which lets you insert exact values on where the points should be created. Activate the Pen Tool now, 
you’ll find it in the “Create” Tab. Once activated, press “n” on your keyboard to bring up the Numeric 
Panel. As you can see in the Numeric Panel, the default values for all the axis are set to zero, and if 
you look at the centre of the Universe in the Back View, you should notice that a point has been 
placed there, like in picture 17. 
 

 
Picture 17: The Numeric Panel for the Pen Tool 

 
The first point has been created, so close down the Numeric Panel now by clicking the “X” at the top 
right of the Panel, but keep the Pen Tool activated. 
 
We will use the Pen Tool to place points in the shape we want the Bowl to be, and as we place our 
points, Modeler will connect them with polygons automatically. I used a total of 29 points for my shape, 
and you can use more or less for your shape if you want to.  
 
 
 
 
 



Have a look at picture 18; you’ll see that I’ve numbered each point in which order I created them, so 
try to create a similar shape now.  
 

 
Picture 18: The Basic Bowl Shape, try to create a similar shape 

 
Deselect the Pen Tool once you’re done creating the shape. I created my points in a clockwise order, 
and this will result in that the polygons will face inwards later on when we lathe it. Does it sound 
complicated? Lets have a look at the lathe tool and you’ll know what I mean.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



The Lathe Tool 
 
Now size down the Bottom Left Viewport until all four Viewports are the same size. If you press “a” on 
your keyboard now, the shape we have created will be fitted nicely in all four Views as well. Picture 19 
shows what we have so far. 
 

 
Picture 19: The basic Glass Bowl shape 

 
Click the “Multiply” Tab and then activate the “Lathe” Tool by clicking on it. We are going to have a 
look at the Numeric Panel here as well, so press “n” on your keyboard to bring it up. Once the Numeric 
Panel came up, a real-time preview of the Bowl appeared in the Viewports. As you can see in the 
Perspective View now, the polygons of the bowl are facing inwards, like I mentioned earlier. We can fix 
this easily by flipping the polygons later on when we’re done lathing. So how does the Lathe Tool work 
then? Well it’s quite simple. It takes the 2D polygon shape we created, and it spins it around 360 
degrees, and while it spins it, it creates geometry out of what the 2D polygon shape looks like. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Lets have a closer look at the Numeric Panel then. The amount of sides determines how many times 
the 2D polygon shape should be duplicated when it spins it. The default value is 24, which will do fine 
for this bowl. The centre values should all be set to zero, since that’s where we started creating the 
polygon shape. 
 
The Start and End Angle determines where it should start spinning, and where to stop. Picture 20 
shows an example of this. 
 

 
Picture 20: Testing the Angle values 

 
Picture 20 is divided into two. The picture to the left shows a value of 180 degrees entered for the End 
Angle, making the lathe tool only create half of the Bowl. Using 360 degrees like in the picture to the 
right will spin it all around making the Bowl complete. 
 
So the final settings for the Lathe Tool should be what picture 21 shows. 
 

 
Picture 21: The settings for the Lathe Tool 

 
When you’ve entered these settings, just close down the Numeric Panel and hit Space to perform the 
operation, then press “a” to fit the Bowl in the Viewports. When you’re done with that, press “f” to flip 
the polygons and we’re done! 



 
Assigning Surfaces 
 
What we want to do now is give this Glass Bowl a material. The final surfacing and the creation of the 
glass material will be done in Layout later on, and right now all we have to do is assign a name to the 
Glass Bowl. Press “q” on your keyboard to bring up the “Change Surface” panel. Name this surface 
“Glass Bowl”, set the Specular to 50% and click the “Smoothing” button (to activate it), then just click 
“OK” to apply the changes. 
 
The Glass Bowl is looking a bit rough at this point, but we will take care of that next. 
 
Subpatches 
 
Lightwave can turn objects into Subpatches, which will smooth the polygons out. Then when the sides 
of the object are smooth, we freeze the Subpatches and the object gets a new smooth shape 
permanently. Make sure everything is unselected in Modeler, and then hit “Tab” on your keyboard to 
turn the object into a Subpatch. Notice how smooth the bowl turned out? It should look something like 
picture 22 at this moment. 
 

 
Picture 22: Subpatches activated 

 
Now we want to tell Modeler how much it should smooth the polygons. If you hit “o” on your keyboard 
an Options Panel will open up. You can set various settings here but at the moment we are only 
interested in the “Patch Division” setting. We will use a Division of 3 here so enter that number in the 
“Patch Division” field. This means that each Patch in our mesh will be subdivided 3 times when we 
freeze it. Click OK to close down the Options Panel, and then hit “ctrl+d” on your keyboard to freeze 
the Subpatches. 
 
The object is now back in to a polygon mesh. 
 



Now I need to say something about surfaces and how they work in Lightwave. As you might know, 
light bends when it passes through transparent materials such as glass. At this point, our bowl only 
has polygons facing outwards, meaning it wont appear as solid glass once we render it, know what I 
mean? If we were to create an inside of this bowl, then Lightwave would know that the glass is solid 
and it will know when to start and stop bending the light. We can fix this quite easily, all we need to do 
is to copy the polygons of the bowl, paste them in a new layer and then flip them so that they’re facing 
inwards. Then we will have an outside and an inside for our bowl. 
 
Make sure everything is unselected and hit “c” on your keyboard to copy this bowl object. Now it’s time 
for us to use the Layers. If you look at the 10 small boxes up to the right, you’ll notice that black little 
dot I was talking about earlier in Layer 1 (the box to the very left). This means that that Layer is taken, 
and we know it is, by our bowl object. Activate Layer 2 now by simply clicking in the upper part of the 
box; it should look like picture 23. 
 

 
Picture 23: Layer 2 active 

 
Once you click on Layer 2, the bowl object will disappear from the four Viewports. We have a new 
empty work area for our next procedures, and anything we do in Layer 2 will not affect Layer 1 where 
the bowl is. Paste the object in by hitting “v” on your keyboard, we now have a second bowl which will 
become the inside for our main bowl. 
 
Hit “f” on your keyboard now. This will flip all the polygons in our object, making them face inwards 
instead of outwards. We just need to give this object a new Surface and we are done, so hit “q” on 
your keyboard again and the “Change Surface” Panel will open up. Name this surface “Glass Solid”, 
set the Diffuse to “80%” and the Specular to “0%”. Smoothing should also be turned on. Click OK to 
apply this surface to the object. Now that the Polygons are flipped and the new surface is attached to 
the object, it should look something like picture 18 in the Perspective Viewport. 
 

 
Picture 24: The Flipped polygons with the new surface attached 

 
Hit “x” on your keyboard to cut this object out of Layer 2, then activate Layer 1 again and hit “v” to 
paste it there. You won’t notice any difference since this object will be “inside” the other one, making 
the Polygons double-sided. All we need to do now is merge the points, since we have a lot of 
duplicated points lying around. Hit “m” on your keyboard and the “Merge Points” Panel will open up, 
just select the “Automatic” operation here and click OK. A few thousand points should be eliminated. 



Our bowl object is now finished and ready for Layout, but first we should create some environment for 
it to be in. We’re going to keep this very simple; we’ll just create a box that will act as a room. Switch to 
Layer 2 again and activate the Box Tool, then use the values shown in picture 25. 
 

 
Picture 25: The Box Tool settings 

 
Once you’ve entered the values, just close down the Numeric Panel. Then hit “Space” to deselect the 
Box Tool and to create the box. We need to set a new surface for this object, so once again hit “q” on 
your keyboard, and this time name the surface “Floor”. Set the Diffuse to “80%” and the Specular to 
“10%”, then click OK and the new surface is created. We are going to flip the polygons of this box as 
well, since we want the sides of the box to appear as walls to simulate a simple room; hit “f” to flip the 
polygons now.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Modeler lets you view two or more layers together at the same time, and now would be a good time to 
view the two objects to see what they look like. With Layer 2 still active, hold down “Shift” on your 
keyboard and click on Layer 1. This will make both Layer 1 and 2 active, and the objects in both 
Layers will become visible. Hit “a” on your keyboard to fit the objects in the view, they should look 
something like picture 26. 
 

 
Picture 26: Both objects together 

 
All the objects we need for our scene has now been created. At the upper left of Modeler you should 
see a “File” button. Click this one and select “Save Object As”. When the requester pops up, select a 
place on your hard drive where you wish to save the object. An advice is to create an “Objects” folder 
in your “Newtek” folder, where you keep all the objects you create. Name the object “BowlScene.lwo” 
or something like that.  
 
Since we have 2 layers for this object (the bowl layer and the room layer), Lightwave will save both of 
them as one object, but it will remember what layers were used and what object was in which layer. I’ll 
get back to this later on when we load the object into Layout. 
 
The Tutorial will now pause for a tour of the Lightwave Layout, but will continue after that one is 
finished. 
 
 
 
 
 
 
 
 

 
 



Getting to know Layout 
 
Display Options 

 
As I mentioned before, the Layout is used for completing your scenes. This is where you load in the 
objects you’ve created, edit lights & cameras, animate things etc. As in Modeler, you can now 
customize almost everything to fit your own needs. Menus, Tabs and Viewports amongst other things 
are now editable. I prefer the default settings with one single Viewport, but if you’d like to try your own 
settings then you’ll find various options in the “Display Options” Panel, you’ll reach it by hitting “d” on 
your keyboard. 
 
The Lightwave Universe 
 
This is where the objects you load in ends up, and you can view the universe from several different 
ways, such as from the Camera and from the Lights point of view. Picture 27 shows the Universe. 
 

 
Picture 27: The Lightwave Universe 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



The Properties Panel 
 
We will start by loading in the objects we created. This will make it a bit easier for me to explain the 
different stuff in Layout. To the left where the Toolbar is you should see an “Add” button. Click that 
one, then select “Objects -> Load Object”. You will be represented with a requester, so browse to the 
folder where you saved your object earlier and load it into Layout. Picture 28 shows the Layout after 
the object has been loaded. 
 

 
Picture 28: The objects loaded into Layout 

 
The “Objects” Item is selected by default when you load Layout up, and now that we have objects in 
our scene, we can also access the Properties Panel for the Objects. All 4 Items (Objects, Bones, 
Lights and Cameras) have a Properties Panel, and we will take a closer look at them now. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Object Properties 
 
Keep the “Objects” Item selected and hit “p” on your keyboard to bring up the Properties Panel, you 
can also access the Panel by clicking the “Item Properties” button at the bottom of Layout. The Panel 
that comes up should look like picture 29. 
 

 
Picture 29: The Properties panel 

 
This Panel gives you many ways of altering the appearance of your object in the final render. At the 
top of the Panel you can see how many objects there are in the scene, in this case 2. Just below of 
that you can select which object you wish to work with in the “Current Object” pull-down menu. The 
Tools have been divided into 4 categories: 
 
Geometry, Deform, Render, Edges and Lights. 
 
In the Geometry Tab you can adjust settings such as the Subpatch Level of Subpatched objects. Right 
now we don’t have any objects in our scene which are subpatched, so for our scene we don’t need to 
worry about these settings. 
 
The “Deform” Tab lets you deform your objects in certain ways, such as adding a Displacement Map. 
Displacing requires that the object has got many polygons; since it will actually alter the geometry of 
an object, i.e. deform the objects mesh. An example is landscape Displacing, you can load in a simple 
flat plane with many polygons into Layout, apply a displacement map and it will look more like a 
terrain. 
 
 
 
 
 



In the “Render” Tab you’ll find various settings on how the object should appear when you are 
rendering an image. Should the object receive or cast shadows? Should it be seen by the Camera? 
Well, these are some of the settings you can alter here. 
  
In the “Edges” Tab you can add certain effects of how you want the edges of your object to turn out in 
the render. Best way to get to know them is to simply try them out sometime one by one. One I have 
experienced a lot with myself is the Silhouette effect, which lets you add an outline to your objects, 
making them look more cartoon like. 
 
The “Lights” tab lets you choose whether or not you want the object to receive light, radiosity or 
caustics, as simple as that. 
 
Bones Properties 
 
This is an area I won’t explain so much of in this Guide. I will only cover the basic things any 
lightwaver should know to get started on their own, and I consider bones to be a bit of an advanced 
feature. Anyways, the Bones Properties Panel lets you set the way the bones should behave when 
you use them on an object. 
 
Light Properties 
 
This Panel gives you full control over the Lights in your scene. There must always be at least one light 
in the scene, and when you start Layout up, a Light is added by default. There are 5 types of Light – 
“Distant Light”, “Point Light”, “Spot Light”, “Linear Light” and “Area Light”. Picture 24 shows the 
Light Properties Panel. 
 

 
Picture 30: The Light Properties Panel 

 



You can choose the Colour or intensity the lightsource should have, if it should have a distance fall-off 
and many other things. Distant, Point and Spot Lights can have Volumetric Light effect. In real world, 
this effect appears when you for example use a flashlight in a dark & misty room, where you can 
actually see the light as it passes through the air; i.e. as if particles were flying around in the air.  
 
If you click the “Global Illumination” button at the top of the Light Properties, a new Panel should 
appear. This Panel lets you set effects such as “Radiosity” and “Caustics”.  
 
Maybe you already knew, but in the real world light bounces on almost every material, more or less 
depending on what kind of material it is. This is what “Radiosity” does. If you activate Radiosity in a 
scene, the light that comes from your Lightsource will bounce on the objects you have in your scene, 
and this enhances the realism of the image very much. It takes longer to render with Radiosity though, 
but it sure is worth it. 
 
Have you ever been underwater a sunny day and noticed how the light casts hotspots on the ocean 
floor? This effect is known as caustics. It takes longer to render but is a pretty neat effect. Keep 
Caustics and Radiosity set to “Off”, we don’t need to use them. 
 
The Camera Properties 
 
This Panel lets you change the way the Camera should behave when you render an image. Here you 
set things like Image Resolution and Anti-aliasing. Picture 31 shows the Camera Properties Panel.  
 

 
Picture 31: The Camera Properties Panel 

 
 
 



The Editors 
 
There are 4 Editors in Layout. “Scene Editor”, “Graph Editor”, “Surface Editor” and the “Image 
Editor”. These 4 Editors are always available in the Toolbar to the left of Layout; it doesn’t matter in 
which Tab you are. I won’t explain the Scene and Graph Editor that much, since they are a bit more 
advanced with their Tools, but they are generally there to give you more control over the scene, and to 
help you animate your objects better and faster. 
 
The Surface Editor 
 
This is where you edit your surfaces. Picture 32 shows the Surface Editor. 
 

 
Picture 32: The Surface Editor 

 
As you can see to the left, the object name and its surfaces are listed. To the right of that list, you have 
a real-time preview of the surface that you are editing. You have 4 Tabs with different Tools to alter 
and change your surfaces. “Basic”, “Advanced”, “Environment” and “Shaders”.  
 
 
 
 
 



The Basic Settings 
 
Color lets you set the colour of a surface. 
 
Luminosity refers to how much the surface will glow on its own light, remember though that if this 
setting is on, the object won’t appear as a light (won’t cast shadows etc). 
 
Diffuse lets you choose how much light the surface should attract. High Diffusion will result in that the 
surface appears bright, and low diffusion will result in that the surface absorbs most of the light and will 
therefore appear darker. 
 
Specularity lets you set highlights on your surface, which is often used on smooth shiny objects. 
 
Glossiness will determine how spread out the Specularity is; note that you have to have a Specular 
value set for this option to be available. 
 
Reflection speaks for itself, it lets you change the amount of reflectivity the surface should have. 
 
Transparency is a way to make your object go transparent, which is a must when you are creating 
glass surfaces and such. 
 
Refraction Index sets how much the light should bend when it passes through a certain material. 
Note that you have to have a transparency value set for this option to be available. 
 
Translucency is a different kind of transparency. You can’t see through a translucent material, yet 
light can pass through it. Like the shade of a lamp, where the actual light gets through, but you can’t 
see through it. 
 
Bump is a way to add bumps to your material. Every real world object has bumps to some degree and 
this is where you simulate them. 
 
Smoothing and Smoothing Threshold lets you smoothen out the polygons on your objects surfaces. 
Our glass bowl is a good example where the surface should be smooth. 
 
When you are creating new surfaces, the best way to get to know the basic settings is to simply try 
them out one by one. 
 
Presets 
 
You can save any surface you create for later use, and this is where the “Presets” Panel comes in. In 
the Tools menu to the left in Layout you should see the Presets button, click that one and the Panel 
should open up, looking something like picture 33. 
 

 
Picture 33: The Preset Window 

 
 
 
 



At the top of the Panel you should have a pull-down menu, with “Workspace” currently selected. This 
is the place your surfaces end up when you choose to save them. As you can see I have 1 surface 
saved in my Workspace, and loading it is simple, just double-click it. We will try this more later on 
when we are altering the surfaces. 
 
Lightwave comes with a bunch of pre-made surfaces, and these are located in different categories in 
the pull-down menu at the top of the Presets Panel. I deleted all mine because I never use them and I 
prefer to create all the surfaces on my own, but as a beginner it might be good to check them out and 
perhaps learn a bit on how they are built up. 
 
The Surface Panel isn’t the only one that has got a Presets Panel. For instance, if you were to use a 
volumetric light in your scene, you can find pre-made light settings in the Presets Panel within the 
Lights Panel. Check it out sometime. 
 
Advanced, Environment & Shaders 
 
A bit more advanced settings for your surfaces can be set within these 3 Tabs. If you have a reflecting 
surface, you can set how it should behave in the Environment Tab. You can use an image as a 
reflection map for your surface, or you could just trace the reflection for real. In the “Shaders” Tab you 
can add Shaders that will help you achieve certain materials better. 
 
The Image Editor 
 
This is where you load in all the images you need for your scene. You can even adjust certain settings 
on your images such as Brightness and Contrast. Picture 34 shows the Image Editor. 
 

 
Picture 34: The Image Editor 

 
 
 
 



Effects 
 
Okay, you can close down the Image Editor now and then click the “Scene” Tab at the top of Layout. 
Once you click it, the menu to the left will change, and you will have a new set of Tools to work with. 
Click the “Backdrop” button to the left, and a new Panel should open up, looking like picture 35. 
 

 
Picture 35: The Effects Panel - Backdrop 

 
Here you can add certain environment settings, such as a gradient backdrop. You can set the colour 
of the sky and the ground. This effect is just basic and won’t let you add clouds and stuff like that. 
Skytracer on the other hand lets you configurate a somewhat better looking sky, with clouds, sun & 
moon and stuff like that. The result is not that breathtaking but it’s still pretty cool. The Skytracer is 
added with the “Add Environment” pull-down menu at the bottom of the Backdrop Tab (within the 
Effects Panel). 
 
You can add some basic fog in the “Volumetrics” Tab, and this is also where you add and configurate 
the HyperVoxels plug-in. HyperVoxels is a way to convert points into volumetrics, such as fire, water 
and many other things. 
 
In “Compositing” and “Processing” you’ll find various Tools to change the look of your final renders, 
such as adding backdrop images that will appear behind every object in your scene. If you had a Glow 
value set on one of your surfaces, this is where you turn the actual Glow on, and you can also set how 
big the glow should be, and what intensity it should have. 
 
Lightwave also comes with a built in Particle System. You can add many types of effects that can 
affect your objects. I won’t explain this in detail, because it would take too long, but you should know 
that it exists, and you should definitely try it out someday. 
 
This ends our tour of Lightwave Layout, and now we will finish the Tutorial. 
 
 
 
 
 



Finishing the Tutorial 
 
Since we already have the objects loaded into Layout, we can now start adjusting the scene of how 
we want the final render to look (If you don’t have the objects loaded, click the “Items” Tab at the top 
of Layout, select “Add -> Load Object”, then browse to where you saved it and load it in). First of all 
we will place the camera to the correct position. Click to select the “Camera” Item at the bottom of 
Layout, then change the view of the Universe to “Camera View”. You should now view everything 
from the Cameras point of view, like in picture 36. 
 

 
Picture 36: What the Camera sees 

 
Adjusting the Camera 
 
When you have the Camera Item selected, activate the “Move” Tool in the Toolbar to the left. Now edit 
the Position window at the bottom left of Layout and use the following settings. 
 

 
Picture 37: The Cameras Position 

 
 
 



When you have entered all three values, hit “Enter” on your keyboard to create a keyframe for the 
camera. This will make Lightwave remember that we moved the camera to this position. Once you hit 
Enter you should be represented with a window, just accept the default values and click OK here. Hint, 
clicking Enter twice in a row is a fast way to create a keyframe on the current frame you’re on. 
 
Now it’s time to rotate the camera. Select the “Rotate” Tool to the left of Layout, and then use the 
following settings in the Rotation window at the bottom left of Layout. 
 

 
Picture 38: The Cameras Rotation 

 
This will rotate the Camera; hit “Enter” again to create a keyframe, so that Lightwave will remember 
the Rotation we just made. Finally open up the Properties Panel for the Camera and change the Zoom 
Factor to 2.5, this will make the camera seem more focused on the bowl.  
 
Adjusting the Light 
 
Activate the “Lights” Item at the bottom of Layout, then hit “p” and the Properties Panel should come 
up. Use the following settings for the light. 
 

 
Picture 39: The Light Properties 

 



Note! You have to change the Light Type into an Area Light before you can apply the Intensity Falloff. 
Once you entered all the settings, click the “Global Illumination” button, and use the following 
settings in the Panel that comes up. 
 

 
Picture 40: The Global Illumination settings 

 
Once you’ve entered the values, you can hit “p” twice to close down both this Panel and the Light 
Properties Panel. Now change the view of the Universe to “Light View”, so that we see things from 
the Lights point of view, it’s time to move, rotate and scale the Light. 
 
Keep the “Lights” Item selected and activate the “Move” Tool. Use the following settings in the 
Position window. 
 

 
Picture 41: The Lights Position 

 
 
 
 
 
 
 



Next activate the “Rotate” Tool and use the following settings in the rotate window. 
 

 
Picture 42: The Lights Rotation 

 
To make the light throw light at closer range, we also need to scale/size it down. Activate the “Size” 
Tool and use the following settings in the Scale window. 
 

 
Picture 43: The Lights Scaling 

 
Once you changed all the values, create a keyframe. Since we are viewing things from the Lights point 
of view, the Universe should now look something like picture 39. 
 

 
Picture 44: Viewing from the Lights point of view 



We are going to clone the Area Light that we have to give the scene a bit more softer light. Select the 
Light as current Item and then select “Add -> Clone Current Item”. A question will pop up asking you 
how many clones, so just enter 1 and click OK. We are going to change some of the properties for this 
light, so with the new light selected, press “p” to bring up the properties panel again. Use the settings 
shown in picture 45. 
 

 
Picture 45: The properties for the second light 

 
When you’re done with the basic settings, click the “Shadows” Tab within the Properties Panel and 
set Shadow Type to OFF here, we don’t want this light to cast shadows. Time to move and rotate this 
light, use the following values when you Position and Rotate the Light. 
 

 
Picture 46: The Lights Position 

 
Picture 47: The Lights Rotation 

 
The Size is already set to the correct value, since we cloned the first light. Once you’ve moved and 
rotated the light, create a keyframe save the changes. 
 
 
 
 
 



Now we’re pretty much done with setting this scene up, all we need now are some materials for those 
objects. If we change the view of the universe to Top now, this is what the scene looks like. 
 

 
Picture 48: The scene is done, viewed from Top 

 
Change back to Camera View once you’re done.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Lets try a test render to see what it looks like so far. Open up the Camera Properties and set the 
Resolution to 800x600. At the top left of Layout you’ll see a Rendering Pull-down menu. Click this and 
select Render Options, then use the following settings. 
 

 
Picture 49: The Render Options 

 
At this moment we don’t really need Trace Reflection, Refraction and Transparency, but since we’re 
creating a glass bowl we’ve got these settings set already. So close down the Render Options Panel 
and press F9 on your keyboard and let it render! Picture 50 is my test render result. 
 

 
Picture 50: The first test render 



So lets get on with those materials. Open up the Surface Editor, select the Floor Surface and use the 
following Basic settings. 
 

 
Picture 51: Floor Surface Basic settings 

 
 
 
 
 
 



We are going to add a fractal pattern to this surface, so click the “T” for the Diffuse Channel and use 
the following settings. 
 

 
Picture 52: A Procedural texture for the Diffuse Channel 

 
Now since we’re using 5% for Layer Opacity here, it won’t be strong at all. Click Use Texture once 
you’re done, and that’s it for the Floor Surface. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Next is the Glass Surface, so select it from the list and use the following Basic settings. 
 

 
Picture 53: The Basic settings for the Glass Surface 

 
 
 
 
 
 
 



We are going to add two procedural textures for this surface, so click the T for the Transparency 
Channel and use the following settings. 
 

 
Picture 54: The Transparency procedural texture 

 
This will add some variation to the transparency, but a very subtle one since the Opacity is set to 5%. 
Click Use Texture once you’re done. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Lets add some bump to, click the T for the Bump Channel and use the following settings. 
 

 
Picture 55: A Bump texture 

 
Just click Use Texture when you’re done to save these changes. That’s pretty much it for the Glass 
Surface and now we only have one surface left, the Glass Solid one. This will be quite easy, because 
we’re just going to copy the Glass Surface, paste it to the Glass Solid one and just change it around a 
bit. Keep the Glass Surface selected and double-click the 3D preview of the texture, this will copy the 
texture to the Presets Panel. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



If you look in the Presets now, you should have the Glass Bowl Surface under the Workspace 
Category. Now switch to the Glass Solid surface in the Surface Editor, then double-click the Glass 
surface in the Presets Panel to load it in. We are going to keep the two texture channels, so just 
change some of the Basic settings to the following. 
 

 
Picture 56: The Glass Solid basic settings 

 
Well that’s it for the surfacing part! 
 



Looking through the Cameras eyes, the scene should now look something like picture 57. 
 

 
Picture 57: The finished scene 

 
Now, click the “File” pull-down menu button at the top left of Layout. We are going to save both the 
objects and the scene, so first select “Save -> Save All Objects”, and then select “Save -> Save 
Scene”. Choose a place and a name for the scene file. Now all we need to do is render this image. 
Open up the Camera Properties once more, this time change the Antialiasing level to Enhanced 
Medium, then close the Panel down. In the Render Options Panel, click the “Output Files” Tab and 
then click the Save RGB Button. Choose a name and a location for the finished render and click OK. 
Also make sure you change the Filetype for the output image, I set mine to JPG. 
 
Once done just close down the Render Options Panel and once again save the scene file, then press 
F10 to render the image! 
 
I hope the result of the render was satisfying and above all I hope that you learned something from 
this Guide and Tutorial. 


